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Foreword
Information in this documentation is subject to change without notice and does not bear 
any commitment on the part of I.R.I.S.

 

The software described in this document is furnished under a license agreement which 
states the terms of use of this product. The software may be used or copied only in 
accordance with the terms of that agreement.

No part of this publication may be reproduced, transmitted, stored in a retrieval system, 
or translated into another language without the prior written consent of I.R.I.S.
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System Requirements
The minimum required specifications to run Readiris PDF are:

 

Software requirements

Component Requirement

Computer and processor 1.5 GHz processor or higher

Memory 8 GB RAM or higher

Available hard drive space 5 GB or higher

Operating System Windows 10, Windows 11,  64-bit

Other Internet connection

 

Hardware requirements
Readiris PDF uses all computer resources (CPU and GPU), so the more resources you 
have, the faster the application will run.  

The minimum screen size for an optimal user experience is 13 inches. 

For compatibility with scanners, go to Configure your scanner.

 

Caution: small form factor PCs or virtual machines may not be 
compatible.
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Download and Install
Before you try and install Readiris PDF, make sure you have the necessary administrator 
rights to install applications on your computer.

 

Download
Visit www.irislink.com to download Readiris PDF

 

Install Readiris PDF

Tip: Run the installer from your local drive. Running the installer from a 
virtual or an external drive may display security messages.

Note: Some Operating Systems might require a reboot before opening.

Note: This is a trusted application. If your antivirus software generates a 
warning message, you may proceed.

Note: The first launch after installation may take a little longer.

Double click the executable installation file (.msi) to start the Installation Wizard1

Follow the on-screen instructions to finish the installation.2

https://www.irislink.com/
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Activate Readiris PDF
Once you have installed Readiris PDF, you need to activate it.

 

Note: An Internet connection is required!

 

With a Product Key
Activation

The information about your license in the right panel License is updated.

 

Deactivation
To reuse the same Product key on another computer, you must first deactivate it on 
your current computer (one active use at a time). 

Once confirmed, it is ready to reuse. 

 

Go to File  > Activation   > Activation Code. 1

Enter your Product Key (22-character code) in the Activation code Panel.2

Click on Online activation.3

Copy and paste the current Product key in the Activation code Panel.1

Click on Online deactivation.2
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Open Readiris PDF
Double-click the Readiris PDF icon on the Desktop to launch the application.

Note: This is a trusted application. If your antivirus software generates a 
warning message, you may proceed.

Note: Only one application instance can run on the same computer.

 

Set as default PDF reader
At launch, a message asks you if you want to set Readiris PDF as the default application 
for opening PDFs.

Click Yes and a message will inform you how to proceed.

You can also click No and decide later.
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Exit Readiris PDF

OR

Go to the upper-right corner of the title bar1

Click on the Close button 2

Go to File Menu  1

Select Exit the application 2
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Navigate the interface
Readiris PDF offers you two menu modes: an office-style Ribbon and a Modern Menu 
based on a 'input-process-output' workspace.

What is the 'Input -> Process -> Output' concept? 

It is an intuitive workspace divided into 3 main areas:

At any time, you can toggle between office-style Ribbon or Modern presentation by 
pressing F12.

 

Tip: When hovering the pointer of your mouse on an icon or a button, a 
tooltip appears, giving you information about the item.

 

 

Input Area
The upper left area of the interface is dedicated to Inputs.

You can find more detailed explanations about this panel in the Import chapter.

 

A the top left, you import and set the document(s) you want to work on•
In the center, you process and edit the documents•
At the top right, you define your output and export (save) your result.•
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Process Area
The central area and its complete workspace just below are dedicated to document 
processing. In short, we will just call it the Workspace. 

 

The features icons bar (main menu) contains all the possible actions/processes to 
perform on your documents. 
In the Preferences, you can choose to display those actions in a classical Ribbon 
mode. 
You can find more detailed explanations on each feature in the Process chapter.

1.

The Tab bar allows you to see which document is currently open for processing. By 
right-clicking on the title, you can rename the document, merge it, or close all 
documents (all tabs). By pressing F2, you can rename the document.

2.

The main Viewer allows you to process your document and view your actions. 3.

The Viewer Toolbar allows you to:

Icon Tooltip Description

View Previous/Next 
page

Move through pages

Toggle Scrolling/ 
Single- page/ 
Multi-page View

Toggle between the scrolling view, the single-page 
view or the multi-page view. 

By default, the scrolling view is on. The scrolling 
view allows you to scroll vertically all the pages of 
your document. 

4.
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The single-page view allows you to visualize the 
page objects (zones and annotations) and to edit 
text. 

The multi-page view allows you to organize your 
pages.  By right-clicking on a page, you access the 
cut, copy, paste, split, merge and delete options. 
You can zoom in or zoom out with Ctrl+mouse 
wheel. You can reorder pages with drag and drop 
or cut, copy and paste.  You can select multiple 
pages with Ctrl+click. (see Keyboard shortcuts for 
further options).

Select items
Select objects on the page or draw areas on the 
page with your mouse cursor. 

Move inside image
Move around the page following your mouse 
cursor (similar to scrolling up or down as well as 
left or right at the same time)

Zoom

Zoom to fit the window size.•
Zoom to fit the page width.•
Zoom to fit the page height.•
Zoom in/out: define the display of your page 
(in percentage). Use the buttons +/- OR type in 
a number OR use the shortcut Ctrl+ mouse 
wheel.  On a tablet, use your thumb and index 
on the touchpad and pinch in or stretch out.

•

The left navigation panel allows you to visualize and control the items present at 
document level. You can customize the display thanks to the slide button show/hide.

5.

Thumbnail panel : allows you to preview the pages of your document (in 
scrolling or single-page view). By right-clicking on a thumbnail, you access the 
cut, copy, paste, split, merge, extract and delete options (see compose features). 
You can zoom in or zoom out with Ctrl+mouse wheel. You can reorder pages 
with drag and drop or cut, copy and paste.  You can select multiple pages with 
Ctrl+click. (See Keyboard shortcuts for further options).

•

Bookmark panel: the list of existing bookmarks is displayed. When you click on 
a bookmark, the target page is displayed. Go to How to: PDF bookmarks for 
more details.

•

Attachment panel: the list of Attachments is displayed. If you select an 
attachment, the page on which it is located is displayed. An attachment icon  

 shows you the location. Go to How to: PDF attachments for more details.

•
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Output Area
The upper right area of the interface is dedicated to Outputs.

You can define the settings of format and destination of your exports.

You can execute your exports (cf. Save button). 

You can find more detailed explanations about this panel in the Export chapter.

You can send your document to the printer. 

 

Note: You can show or hide the left panels and the Settings panel by 
clicking on the show/hide arrow  .  

 

Zone panel: displays the list of zones and Smart Zones. Go to Edit > Page 
analysis for more details on zones. Go to Edit > Smart Zone for more details on 
Smart Zones. 

•

Content panel: displays the list of additional content items (image, text, or 
barcode). These content items are applicable to all output formats. Go to Edit 
for more details.

•

Comment panel: displays the list of PDF comments. These comments are only 
exported with the PDF output format. Go to Comment for more details.

•

Protection panel: displays the list of protection items such as signature or 
password (for PDF format).

•

Properties panel: displays the current document properties (number of pages, 
page size and resolution, document language). 

•

The Settings panel (dynamic panel) allows you to view settings in the context of 
your current process. 

6.

The Search box in the Title bar allows you to search and find text in the active/ 
current document. Go to How to search and replace for more details.

7.

The Quick Access Toolbar allows you to access common commands no matter which 
process menu is selected. By default, it shows the Save as..., Undo, Redo, send to 
Email and send to Printer commands, but you can customize other commands 
depending on your needs via the drop-down list indicated by the down arrow icon  .

8.
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Print
The Print button   opens the print page. For a description, go to chapter Print.

 

File menu
The File Menu  opens a navigation rail. 

Icon Description

Info. Gives you information about this software (version, serial number)

Open. Allows you to open a document from Files, Scanner or Clipboard (cf. 
Import) and shows you the recently opened documents. 
Also, gives you access to several actions via shortcuts: create PDF, edit and 
modify, convert PDF, annotate and comment PDF, combine PDF, batch 
processing, and help.

Save. Allows you to save your active document to various destinations (local 
computer, email, Cloud) and includes shortcuts to convert to other formats.

Save as... Opens a Save As dialog to save your document locally.

Close document. Closes the current active document.

Share. Gives you access to your favorite shared destinations via shortcuts (Email, 
Cloud)

Print. Opens the print page. For a description, go to chapter Print

User Settings. Allows you to set your preferences

Activation. Allows you to activate this software

Update. Allows you to search for updates

Help. Opens the User Guide

Exit the application



Readiris PDF

                                                                                                       15 of 82 

Preferences

 

User Interface
Light or dark mode

By default, the light mode is on. 

Click on the slide button to switch to the dark mode. 

 

Ribbon or Modern presentation

By default, the Ribbon presentation is on. The groups of commands are displayed in a 
classic Ribbon (with tabs). 

However, the same groups of commands can be displayed in an icon bar, which is called 
the Modern mode.  This documentation is mainly based on the Modern presentation, to 
help you familiarize with it.  Tooltips help you to understand the icons. 

Click on the slide button  to switch to Modern mode. You can also press F12 to 
toggle between the two modes.  

Modern 
mode

  

Ribbon mode

 

Remember session

By default, your workspace (active tabs) is not remembered at closing of the application. 
When starting again, go to File Menu > Open > Recent documents to reopen your latest 
documents, or, to save your workspace at each closing, click on the slide button to 
activate the Remember session option. 

 

Go to File Menu  1

Select User Settings   2
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Change the interface language

Select your interface language within the 'Languages' drop down list.

Legal Notice
By default, the Usage Intelligence is on. 

Click on the slide button to switch it off. 

 

OCR Settings
Favor text over layout

The default OCR settings favor the layout over the text. This means the result after 
recognition will be as close as possible to 'what you see is what you get'. 

However, you can choose to favor text over layout (click on the slide button to switch 
mode).  By doing so, Readiris PDF will give the focus on the text and therefore might give 
a different result of what you see.  

 

Automatic Language Detection (ALD)

Note: By default, the Automatic Language Detection is switched on and 
excludes manual settings. 

 

 

Readiris PDF can detect the main OCR language automatically.  The aim of this feature is 
to automatically detect the most probable language on a page.
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The Properties panel shows the detected language of the document.  To modify the OCR 
language easily and even add two additional OCR languages (e.g. for documents mixing 
languages), go to Edit > Languages.  The Settings panel opens.  You can apply these 
settings to all pages at once by clicking Apply to all pages.

 

ALD supported languages 

English, German, French, Spanish, Italian, Swedish, Danish, Norwegian, Dutch, 
Portuguese, Galician, Icelandic, Czech, Hungarian, Polish, Romanian, Slovak, Croatian, 
Slovenian, Finnish, Turkish, Estonian, Lithuanian, Latvian, Albanian, Catalan, Irish Gaelic, 
Scottish Gaelic, Basque, Indonesian, Malay, Swahili, Tagalog, Haitian Creole, Kurdish, 
Cebuano, Ganda, Kinyarwanda, Malagasy, Maltese, Nyanja, Sotho, Sundanese, Welsh, 
Javanese, Azeri (Latin), Uzbek, Bosnian (Latin), Afrikaans.

Serbian, Russian, Belarusian, Ukrainian, Macedonian, Bulgarian, Kazakh.

Greek. 

Hebrew.

Arabic, Farsi.

Traditional Chinese, Simplified Chinese, Japanese, Korean. 

 

Note: Similar variations of a main language are assimilated. E.g. Spanish 
assimilates all variations of Spanish, Portuguese assimilates Brazilian or 
French assimilates all variations of French.

 

Manual setting

 

Switch off the Automatic language detection (ALD) by clicking on the slide button 
next to it. 

1

Select manually an OCR language from the OCR Languages drop down list. 2
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Import documents
With Readiris PDF you can open or scan a various number of file formats and use them 
as input. 

 

Supported input specifications

Input type Specifications

Resolution  from 96 to 1200 DPI

PDF versions

PDF 1.3, 1.4, 1.5, 1.6, 1.7

Extension Level 3 (AES encryption)

iHQC - PDF compressed (all levels) (from I.R.I.S)

Image formats JPG, JPEG, JPG2000, TIF, TIFF, BMP, PNG

MS Office formats .DOC, .DOCX, .XLS, .XLSX, .PPT, .PPTX

 

Warning: For a correct image handling and processing, make sure your 
image size does not exceed 75 megapixels

Tip: To configure your input settings, go to Configure input settings.

 

In the Ribbon mode, go to tab Home > Capture to access the import menus and 
options: 

 

 

Open from local files
In the input area, click on Open   or press F51

The file browser opens, select your file to import2
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Or simply drag and drop a file from the file browser.

 

Import pages from a scanner

 

Create a new document or append to current document
A slide button  allows you:

OR

 

Note: You can Rename the title of your document by right-clicking on 
the tab title or by pressing F2.

 

'On the fly' Operations

This button  allows you to activate or deactivate 'On The Fly' operations during 
import. By default, this option is enabled. 

This option offers three automatic operations that can be configured and applied while 
opening a file or scanning a document: automatic image processing, automatic 
separation or automatic naming.  

For example, this can be useful if you want to open a long file with several pages and 
automatically split it into several documents. Or, if you want to scan several documents in 
one batch and split automatically that batch into separate documents.  In both cases, you 
can also add a rule to automatically name each new document. 

To configure these operations, go to the settings of each input source.

Click Open3

In the input area, click on Scan   or press F41

The first time, a pop-up window opens for you to select your source scanner.  Once 
your source is selected, clicking on the Scan button will launch the scanning

2

to import more files by creating a new document (create in a new document)  .  
This is the default setting. Then when you import from a scanner, a pop-up window 
opens asking you to name the new document. Once the name is confirmed, the 
scanning is launched. A new tab is created for each new document in the tab bar.

•

to import more files into the current document (append to current document)  . 
The imported pages are added to your current document. You can see them in the 
thumbnail view.  More help at How to scan multiple pages into one document. 

•
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If you do not need these automatic operations, you can quickly disable the 'on the fly' 

operations option by clicking on the button  / . 

In the Ribbon mode, this button is a checkbox: 

 

Import from Clipboard
You can import content from your clipboard thanks to the Ctrl-V shortcut.   This can be 
done into an existing document or into a new document.

For an existing document: 

 

For a new document:

 

Open an existing document.1

In the thumbnail panel (or multi-page view), select with your mouse cursor the 
place (between pages - red line) where you want the new page to be created.

2

Press Ctrl-V or right-click your mouse and select Paste (Paste Before or After if you 
right-clicked on a page). 

3

A new page is created in your document with your clipboard content. 4

Create a new document by pressing the plus sign ( ) in the tab bar.1

Enter a document name. Click OK.2

Press Ctrl-V.3

The clipboard content is pasted in your new document. 4
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Configure input settings
 

Configure your local folder 

 

Configure your scanner 
Readiris PDF is compatible with: 

TWAIN

It supports almost any flatbed and sheet-fed scanner, all- 
in-one device, digital camera and scanner currently 
available. A TWAIN scanner requires a TWAIN driver. 
Make sure it is installed. 

32-bit drivers It supports 32-bit scanners only

Simplex & Duplex Scanners that offer duplex scanning are supported

USB  Scanners with USB plugin are supported

Network or Wi-Fi

Scanners that are available on a network or wireless 
network. Note that network and Wi-Fi scanning must be 
properly configured for the scanners to be visible to 
Readiris PDF.

 

In the input area, click on the Option menu   (Input settings) under the Open 
button . A window opens.

1

Select the file format you want to consider for importing.2

By default, the 'Use file name' box is checked.  Thus, your document reuses the same 
name as the file.  
If you uncheck this box, the file name is not kept and you are asked for a name when 
creating a new document.

3

If necessary, customize the rules for 'on the fly' operations. 4

In the input area, click on the Option menu   (Scan settings) under the 

Scan button  . A window opens.

1

Select your scanner from the drop down list.  All the available scanners (i.e. 
connected to your computer) have been detected. 

2
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Note: In the Ribbon mode, go to tab Home > Capture. Clicking on the 
small down arrow besides the From File button or besides the From 
Scanner button opens the settings windows.  

 

 

'On the fly' Operations
Whether you are opening a file or scanning a document, you can define 'On The Fly' 
Operations.  

The three automatic operations are as follows:

1. Image processing operations

Four image processing operations are available: 

Select the operations you want to be executed while opening a file or scanning a document.  
Combinations are allowed. Be aware however that the more operations you select, the 
more time the opening or the scanning will take.

2. Automatic separation

An automatic separation of documents can be configured according to certain 
conditions and thus be executed when opening files or scanning papers. The system 
follows the configured condition to apply the separation. The separation creates a new 
document. There will be as many documents as there are separations.  

Automatic separation can be based on a:

Condition Description Options

Page counter E.g. If the page counter is 
2, then the separation is 
done every two pages.

 

If necessary, customize the rules for 'on the fly' operations. 3
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Barcode

Separation is performed 
each time a barcode is 
encountered (anywhere 
on the page). If there is 
more than one barcode 
on a page, the first one 
found is taken into 
account. 

You can select the barcode 
type (among those supported 
by Readiris PDF) and the 
barcode content. The barcode 
content can be any, changing 
or fixed.  When you select a 
fixed barcode content, you can 
type all or part of the content to 
search (the search is not case 
sensitive).  

You can decide to delete all the 
pages that are used as 
separators by simply checking 
the "Remove separator pages" 
box.

Blank page Separation is performed 
every time a blank page is 
encountered.

Check the box "Duplex" if your 
scanner is performing duplex 
scanning. 

Note: Simplex 
scanning relates 
to one page/ 
side of a sheet 
of paper while 
Duplex 
scanning relates 
to both pages/ 
sides of a sheet 
of paper.  

You can decide to delete all the 
pages that are used as 
separators by simply checking 
the "Remove separator pages" 
box.

Smart Zone

Separation is performed 
each time a Smart Zone is 
encountered.  A Smart 
Zone can contain text or a 
barcode. This condition 
requires a fixed page size, 
for example A4 only, since 
the detection is done on 

You can select the Smart Zone 
(created beforehand) and 
its content. The Smart Zone 
content can be any, changing 
or fixed.  When you select a 
fixed content, you can type all 
or part of the content to search 
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this zone only and not on 
the whole page. Go to Edit 
to create and manage 
Smart Zones.

in the Smart Zone (the search is 
not case sensitive).  

You can decide to delete all the 
pages that are used as 
separators by simply checking 
the "Remove separator pages" 
box.

No Separation
No separation applies  

 

3. Automatic naming

Automatic separation can be accompanied by automatic file naming. As each time a 
separator is encountered, a new document is created, you can configure under which 
structure the new document will be named.  However, automatic naming can be applied 
independently of automatic separation. 

A naming structure can contain tags or free (fixed) text. The structure gives tags per 
default, but you can select your favorite tags, and/or add free text.  

The result of your automatic naming structure can be previewed. 

The predefined tags are:

Tag Description and options Result

<FILENAME> or

<DOCUMENT>

<FILENAME> is the tag that 
applies by default when 
importing from files. 

Remember that the 'Use file 
name' box is checked by 

default. 

You can erase this tag from the 
Structure and click the plus 
button   to add it again.

<DOCUMENT> is the tag that 
applies by default when 
importing from a scanner.

The Structure line 
shows you the naming 
structure with tags and 
free text.  You can add 
your own free (fixed) 
text anywhere in the 
structure. Free text is not 
contained between <> 
signs. Below the 
Structure line, you can 
preview the result. 
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The 'Prompt for document 
name' box is checked by 

default. 

 

<DATE>

Click the plus button   to add 
the current <DATE> tag to your 
document name. 

You can select between 3 date 
formats: 

This Structure line gives 
you an example of free 
text + the <DOCUMENT> 
tag + the <DATE> tag 
with underscores as 
delimiters. Preview the 
result. 

<TIME>

Click the plus button   to add 
the current <TIME> tag to your 
document name.

You can select between 2 time 
formats:

This Structure line gives 
you an example of free 
text + the <DATE> tag + 
the <TIME> tag with 
underscores as 
delimiters.  Preview the 
result. 

<COUNTER>

Click the plus button   to add 
the  <COUNTER> tag to your 
document name. 

You need to set the value at 
which the counter will start 
counting: Counter starting at 1 
for example. 

This Structure line gives 
you an example of free 
text + the <DATE> tag + 
the <COUNTER> tag with 
underscores as 
delimiters.  Preview the 
result. 

 

Universal: <YYYY-MM-DD>•
US format: <MM-DD-YYYY>•
EU format: <DD-MM-YYYY>•

<HH-MM-SS>•
<HH-MM>•
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Notes:

 

Invalid characters in the file names are replaced by the hash sign 
(#).

•

Each separation method has an associated naming structure 
preset. Changes you make to these presets are persistent. To reset 
the default presets, click the Reset Naming Structure button.

•
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Process image
Image processing features  aim to obtain the best possible scan results. The higher 
the quality of the scans, the higher the recognition accuracy.

 

In the Ribbon mode, go to tab Edit > Image Processing to find the image processing 
features.

Some image processing features listed below require setting properties. Thus, a Settings 
panel opens if applicable.  

In the Settings panel, you can modify, apply or cancel your settings.

 

Warning: Rotating pages with PDF comments, or additional 
content can give unwanted results. We recommend that you rotate your 
pages before adding these objects.

 

Options

Icon/tooltip Description Settings

Auto-rotate
Auto-rotate rotates images 
automatically

 

Rotate 90° Rotate 90° clockwise  

Rotate 180°    

Rotate -90° Rotate 90° anti-clockwise  

Deskew
Deskew aligns a scanned image 
horizontally to compensate for 
skewing

 

Contrast 
brightness

Adjust the contrast and the 
brightness levels to color or 
grayscale images

Brightness slider: optimizes 
the intensity of light

•

Contrast slider: optimizes 
the distinction between 
lighter and darker areas

•
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Grayscale
Grayscale converts color images 
into grayscale images

 

Binarize
Binarize turns color and grayscale 
images into binary (black-and- 
white) images

Negative
Negative inverts the colors of the 
scanned documents

 

Crop

Crop the image by defining an 
area.

Once the cropping is applied, 
you cannot come back to the 
original image. You will need to 
import or scan it again.

Click Cancel to remove your 
cropping selection (before 
applying). 

 

Remove black 
borders

Remove black borders (or dark 
surroundings) 

Gamma slider: gamma 
optimizes the contrast and 
brightness in the midtones

•

Brightness slider: optimizes 
the intensity of light

•

Contrast slider: optimizes 
the distinction between 
lighter and darker areas

•

Smoothing slider: it removes 
noise from the scans. The 
higher the value, the higher 
the removal

•

Click on Crop.  The Settings 
panel opens. 

•

Click the mouse and draw a 
box around the section you 
want to crop.

•

Drag and drop the box 
where you want and resize it 
according to your needs.

•

Click Apply in the Settings 
panel. 

•

Border: 1 (low), 2 (medium), 
3 (high)

•
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Remove punch 
holes

Remove black punch holes from 
your page 

 

Perspective 
correction

Correct the perspective 
distortions of your page (3D 
correction)

Downscale Reduce the size of your page

Text Removal

Remove all recognized text 
zones (on single-page view).

If you do not want to delete all 
text zones, you must first cancel 
recognition of the zone you 
want to keep as text. To do this, 
select it in the Zone panel, 
right-click it and select Delete 
from the context menu.

For more information 
on recognition zones. go 
to Page Analysis. 

 

Apply on all images
To apply an image processing on all pages: 

Crop to a selected area of 
the image: tick the box to 
enable the cropping

•

Automatic crop•

Downscale percentage (from 
100% to 1%)

•

Go to the Zone panel to 
show the zones (slide 
button).  Text zones are 
identified in blue. 

•

Click on Text removal.  All 
text zones are removed.

•

In the Settings panel, click 
Apply to confirm the 
deletion or Cancel to go 
back.    

• Type: normal, best quality or 
fast

•

Dilate the text area in pixels 
(from 0 to 10)

•

Radius of the Inpainting 
(from 0 to 15)

•

Go to the Thumbnail panel1

Press CTRL+A2
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Some image processing options display the Settings panel first.  In this case, adjust the 
settings as necessary and then click Apply.

 

Click on the desired image processing3

Wait until the execution has finished running4
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Compose
Compose features   allow you to organize your document.

 

In the Ribbon mode, go to tab Compose > Tools to find the compose features.

Some Compose features listed below require setting properties. Thus, a Settings panel 
opens if applicable.  

In the Settings panel, you can modify, apply or cancel your settings.

 

Options

Icon/ 
tooltip

Description Settings

Split 
document

Cut one or more pages from your current 
document. The split pages are pasted into 
a new document.

 

Merge 
documents

You can merge two files from among those 
open in your workspace. 

 

Open the document you want to split•
Select the page from which you want a 
split to occur (it will include that page 
and the next ones). Use thumbnail 
panel or multi-page mode.

•

Click on Split•
Enter a name for the new document to 
be created

•

The new document is created and 
contains the split content

•

Open the document you want to merge•
Click on Merge. A pop-up window 
opens

•

Choose the Document name you want 
to merge into

•
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To combine multiple files into one 
document directly from the import step, 
use the Append feature. 

Insert 
document

Insert a document from file only

To insert a page/document from a scanner, 
use the Append feature. 

 

Blank page
The blank page is the same size as the 
previous page. If you start your document 
with a blank page, then by default an A4 is 
created.

 

Extract 
document

Extract one or more pages from your 
current document.  The extracted pages 
are not deleted from the current 
document. They are copied into a new 
document.   

Check the box Merge on top if you 
want your document to be inserted 
before (by default, it is inserted after)

•

Click OK•
The first document is added into the 
second one (on top or at the end 
according to your choice)

•

Open the document in which you want 
to insert another one (or more)

•

Click on Insert. A file browser opens. •
Select one or more files•
Click OK•
The selected file is added into the 
current one (after the selected page) 

•

Select a page (from thumbnail panel or 
multi-page view)

•

Click on Blank page•
A blank page is inserted after the 
selected page

•

Open the document from which you 
want to extract one or several pages.  
Select the pages to be extracted (cf. 
thumbnail panel or multi-page view).

•
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Cut
Cut the selected page(s) and copy to 
clipboard (Ctrl+X)

 

Copy
Copy the selected page(s) and copy to 
clipboard (Ctrl+C)

 

Paste
Paste the content of the clipboard (Ctrl+V, 
paste after per default)

 

Delete 
pages

 

 

Tip: From the thumbnail panel or from the multi-page view, you can:

 

Click on Extract•
Choose the Document name for your 
new document

•

Click OK•
A new document is created out of your 
extracted pages

•

Select the page(s) you want to delete 
(from thumbnail panel or multi-page 
view)

•

Click on Delete pages•
A confirmation box appears: click yes 
or no

•

reorder pages by dragging and dropping•
cut, copy, paste, split, merge, extract and delete pages by right- 
clicking on a thumbnail or a page

•
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Comment
Comment features   allow you to annotate your document. 

 

Caution: for most of the comments to appear on your exported 
documents, the output format must be a PDF. 

 

In the Ribbon mode, go to tab Comment to find the annotation features.

Some Review features listed below require setting properties. Thus, a Settings panel 
opens if applicable.  

In the Settings panel, you can modify and apply your settings. 

 

Options

Icon/tooltip Description Settings

Stamp

Add pre-defined stamps 
(e.g. 'Approved' or 'Draft')

To customize or to create 
your own stamps, use the 
Settings panel.

Click on Stamp.  The 
Settings panel opens. 

•

Select the stamp of your 
choice from the list.

•

Click on the page.  The 
stamp is displayed.

•

Drag and drop the stamp 
wherever you want, 
resize or rotate it to fit 
your needs.

•

Create a new stamp by clicking on 
the + button

•

Remove a stamp from the list by 
selecting it and then clicking on 
the - button

•

Text to display (e.g. Confidential)•
Add metadata such as author, 
date, time-stamp

•

Font type•
Font color•
Border type: no border, square, 
rounded square, left arrow

•
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Draw

Draw various shapes on the 
page. 

Signature

Add a stamp of digital 
signature. 

The signature stamp is 
displayed in one location, 
but the signature is global 
for the document. 

Annotation
Add a small text or a sticky 
note to your page.

Click on Draw.  The 
Settings panel opens. 

•

Select the shape of your 
choice. 

•

Draw the shape on the 
page. The shape is 
displayed.  
For Polygon and 
Polyline, draw line 
segments with your 
mouse (one-click each), 
then double-click when 
your shape is finished.

•

Fill in the settings.•
Drag and drop the 
drawing wherever you 
want and resize it to fit 
your needs.

•

Rectangle: select border color, 
background color, border pattern 
(dash), border thickness and 
opacity.

•

Circle: select border color, 
background color, border pattern 
(dash), border thickness and 
opacity.

•

Straight line: select color, dash 
pattern, thickness and opacity of 
the line. Check the box to add an 
arrow at the start or at the end of 
the line. 

•

Polygon:  select border color, 
background color, border pattern 
(dash), border thickness 
and opacity.

•

Polyline: select color, dash 
pattern, thickness and opacity of 
the polyline. Check the right box 
to add an arrow at the start or at 
the end of the line. 

•

Click on Signature•
Click on the page. The 
stamp box is displayed. 
The Settings panel 
opens. Thanks to the 
move cursor, you can 
place the stamp 
wherever you want. 

•

Fill in the settings.•

Digitally signed by (choose an 
available certificate in the drop- 
down list).  
Make sure your certificate is 
loaded in Readiris PDF before 
using it.  If your certificate does 
not appear, restart the 
application.

•

Reason•
Location•
Contact•

Text: write text, select font color, 
background color, border color, 
border pattern, border thickness 
and opacity of the full shape.

•
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The plus button   allows you to 
add a reply to the comment (with 
name and timestamp). Simply use 
the bin button to delete your 
comment if needed.

Watermark

Add a watermark across 
each page.

(Not visible on thumbnail 
and in multi-page view)

Markup

Add markups to words or 
sentences.

Also available with Select 
Text + Right-click

The plus button   allows you to 
add a comment to the markup (with 
name and timestamp). Simply use 
the bin button to delete your 
comment if needed

Redaction

Permanently remove 
(blacking out) sensitive 
information from your 
document.  

Click on Annotation.  
The Settings panel 
opens. 

•

Select a type: text or 
sticky note. 

•

Draw the box on the 
page. The text box or the 
sticky note is displayed. 

•

Fill in the settings.•
Drag and drop the box 
wherever you want and 
resize it to fit your needs.

•

Sticky note: write text, select 
border color. 

•

Click on Watermark.  
The Settings panel 
opens. 

•

Fill in the settings. •

Text to display (e.g. Confidential)•
Orientation (diagonal or 
horizontal)

•

Font type•
Font color•
Opacity slider (from 0 to 255)•
Text size slider (from 30 to 100)•

Click on Markups.  The 
Settings panel opens. 

•

Select a markup type 
and a color

•

Mouse select the 
word or sentence you 
want to markup.

•

Markup type : 
Highlight, Underline, Squiggly line 
or Strikethrough

•

Color: select a color•

Mouse select the 
sensitive text

•

Click on Redact•
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The text is blacked out 
permanently after saving. 

Also available with Select 
Text + Right-click

Attachments

Attach a file to your 
document

The file is attached on the 
current 
page. The attachment icon 

 appears.  Thanks to the 
move cursor, you can place 
the attachment wherever 
you want. 

Go to How to view, add or 
delete attachments for 
further explanations. 

The plus button   allows you to add 
a comment to the attachment (with 
name and timestamp). Simply use the 
bin button to delete your comment if 
needed.

Bookmarks

Add bookmarks to your 
document (PDF output)

A new bookmark is created, 
named and ordered after 
the targeted page number.

Bookmarks are visible from 
the Bookmark panel.

Go to How to view, add, 
rename or delete 
Bookmarks for further 
explanations. 

 

 

Click 
on Attachments. The 
file browser opens.

•

Select your file to import•
Click Open•

Select the page you want 
to bookmark

•

Click on Bookmarks•
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Delete Annotations

 

Select Text + Right-click
If you mouse select some text on a page and right-click, you can access a few shortcut 
actions:

 

 

Select the annotation you want to delete. You can do this either via the PDF 
annotation panel or directly on the page.

1

Press Delete or right-click and select Delete. A confirmation message is displayed. 2

Click Yes.3

copy the selected text•

highlight, underline, strikeout or squiggle the selected text (quick markup)•

redact the selected text•

rename the document with the selected text as title•
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Edit
Edit features   allow you to enter and edit the content of your document.

 

In the Ribbon mode, go to tab Edit > Edit to find the edit features.

Some Edit features listed below require setting properties. Thus, a Settings panel opens 
if applicable.  

In the Settings panel, you can modify, apply or cancel your settings.

 

Warnings:

 

Options

Icon/tooltip Description Settings

Edit Text

Text Editor.  You can edit the 
content of your document at word, 
sentence or paragraph levels.  Go 
to How to use the Text Editor for 
more information.  
Editing text is only possible in the 
single-page view.

Text Reflow: select a 
formatting type: 

The current text editing engine only works with left-to-right 
languages. Support for right-to-left languages will be added later.

•

Recognition, edition, and creation of vertical text are not 
supported.

•

We recommend that you do not rotate your pages before or after 
editing text. Rotating may prevent you from editing text or cause 
random editing of text zones.

•

Automatic rearranges 
automatically the edited 
text in its paragraph frame 
according to the alignment 
options. Resizing the 
paragraph automatically 
rearranges it.

•

Manual keeps the edited 
text on the same line and 
the paragraph width is 
adjusted. The Enter key 

•
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Select:

Create Zone

Create a new recognition zone 
and associate a type to it. cf. Page 
Analysis below

The Zone panel shows you the 
new added zone.

Zone types: image/graphics, 
text, table, or barcode

Smart Zone

Manage a Smart Zone that can be 
used to customize automatic 
separation in 'on the fly' 
operations.

Smart Zone list: drop-down 
list

Name: the default name is 
'Smart Zone' + counter. You 
can edit it. 

Content: this field is filled in 
automatically, as it is 
recognized by Readiris PDF. 
You cannot edit it.  

(new line) must be placed 
manually.

Font and font size•
Font color•
Bold, italic•
Text alignment: left, center, 
right, justify

•

Select the page on which you 
want to create a new zone

•

Click on Create Zone•
Draw a box around the zone 
you want to define. 

•

Fill in the settings in 
the Settings panel

•

Drag and drop the box 
wherever you want.  Resize it 
to fit your needs

•

Select the page on which you 
want to create a new zone

•

Click on Smart Zone. The 
Settings panel opens.

•

Click the plus button and draw 
a box around the zone you 
want to define. The box can 
contain text or a barcode. The 
content is automatically 
recognized. 

•
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To edit an existing Smart Zone, 
select it from the drop-down list 
and change the settings. 

To delete a Smart Zone, select it 
from the drop-down list and click 
on the bin button in the Settings 
panel. 

Languages

Allows you to change the OCR 
language of the current 
document. 

 

Analyse

Each page is divided into 
recognition zones. cf. Page 
Analysis below. 

The Zone panel shows you all the 
recognized zones on a page.  Click 
on the slide button to show/hide 
them. (Page > Zones)

When you click on a zone, the 
Settings panel opens and the 
zone type is shown. There you can 
change it. 

A zone can be moved or resized 
thanks to the move or resize 
cursor.

Zone types: image/graphics, 
text, table, or barcode

Add Image Add an 'image' to your page 

Change the Name of your 
Smart Zone in the Settings 
panel if you want.

•

Drag and drop the box 
wherever you want.  Resize it 
to fit your needs

•

Fill in the settings in 
the Settings panel. You can 
select up to 3 languages in the 
same document.

•

Click on Apply to all pages to 
confirm the change(s). 

•

'Open file' button: browse 
for the image you want to 
use as a stamp

•
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Add Text 
(Stamp)

Add a 'text' stamp to your page

Add Barcode

Add a 'barcode' to your page  By default, the QR code type is 
selected because it offers you 
presets. See How to add a QR 
code for more information on 
the QR type and its presets.

If you want another type of 
barcode, go to the Type field 
and select between Code 39, 
Code 128, Datamatrix or 
PDF417. Fill in the Content 

Select the page on which you 
want to add an image (single- 
page view)

•

Click on Add Image•
In the Settings panel, open 
the file browser by clicking on 
the 'open file' button

•

Browse and Select the image 
you want to add

•

Click Open. The image is 
displayed in the Settings 
panel.

•

Click on the page for the image 
to be displayed

•

Drag and drop the image 
wherever you want. Rotate and 
resize it to fit your needs

•

Select the page on which you 
want to add text as a stamp 
(single-page view)

•

Click on Add Text•
Fill in the settings in 
the Settings panel

•

Draw the box on the page. The 
text box is displayed. 

•

Drag and drop the text box 
wherever you want.  
Rotate and resize it to fit your 
needs

•

Text•
Font type•
Font size•
Font color•

Select the page on which you 
want to add a barcode (single- 
page view)

•

Click on Add Barcode•
Fill in the settings in 
the Settings panel

•

Draw the box on the page. The 
barcode box is displayed.

•
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field and draw the box on the 
page.

 

Delete additional content items

 

What is page analysis?
When you scan a document or open an image file in Readiris PDF, each page is 
automatically divided into recognition zones.

To have them displayed, go to the Zone panel and click on the slide button (show/hide). 

Readiris PDF uses those zones to determine how each part of your documents must be 
converted. If your document does not contain any zones, it cannot be recognized (OCR).

There are 4 kinds of recognition zones. You have text zones, image zones, table zones, 
and barcode zones.

 
Each zone type has its own color.

Text blue

Image/graphics green

Table pink

Barcode light orange

 

Drag and drop the barcode 
box wherever you want.  
Rotate and resize it to fit your 
needs

•

Select the content item you want to delete. You can do this either via the Content 
panel or directly on the page.

1

Press Delete or right-click and select Delete. A confirmation message is displayed. 2

Click Yes.3
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You can also re-launch the page analysis:

 

 

Modifying the recognition zones
To change a zone type

 

Tip: for better recognition of a logo containing text, set it as a 'graphic' 
zone type

Note: if you want to do text editing, use the Text editor.

 

Click Edit   in the Icon bar or Ribbon1

Click Analyze 2

Go to the Zone panel1

Click on the slide button to show the zones. 2

Click on the zone for which you want to change type. The Settings panel opens and 
the zone type is shown

3

Change the zone type between graphic, text, table, or barcode. 4
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Export documents
With Readiris PDF you can save your work under a various number of file formats, 
locally, or export it to the Cloud.  

 

Supported Output specifications

Input type Specifications

PDF versions

PDF 1.4, 1.5, 1.6, 1.7

PDF/A

PDF compressed (all levels) (iHQC - from I.R.I.S)

Extension Level 3 (AES encryption)

Image formats JPG, JPG2000, TIFF, BMP, PNG

MS Office formats .DOCX, .XLSX, .PPTX

Web format HTML

e-Book file format EPUB

 

Warning: For a correct image handling and processing, make sure your 
image size does not exceed 75 megapixels

Tip: For further details on the available settings per format or per 
destination, go to Configure output settings

 

Select your Output format

 

In the output area, click on Output format   . A navigation rail opens listing all the 
possible output formats

1

Select the format of your choice2

If needed, click  on the Option menu   to define the settings of your output format3
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Select your Output destination

 

Save/Save Batch

Once you are ready to export/save, click the Save button   or the Save Batch button 
via the Option menu 

 

Save Batch allows you to save multiple documents in one shot with the same settings.  

The selected documents are being exported/saved.

 

 

In Ribbon mode, go to the Convert tab to find the export formats, destinations and 
Save/Save batch buttons. 

 

Quick Convert
Readiris PDF remembers your latest output format and output destination, so that you 
can simply click the Save button if no change in your settings is needed. 

In the Ribbon mode, the Quick convert buttons are available from the Home tab.  
These are the shortcuts to your favorite output formats, without opening the Settings 
panel.  

A Save As dialog appears allowing you to choose a name and destination for the file.

 

In the output area, click on Output destination  . A navigation rail opens listing 
the possible destinations

1

Select the destination of your choice: Local, Cloud, or Email.2

Click then on the Option menu   to define the settings of your output destination3

 Click on Save batch. A pop-up window opens and list all the currently active 
documents in the workspace

1

 Select the documents you want to save/convert2

 Click OK.  3
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Configure output settings
Settings per format

 

In Ribbon mode, go to tab Convert > Output format. When you select an output 
format, the settings panel opens.  

 

PDF 

Section Option Description

Generalities

PDF type

PDF version 8 PDF versions to choose from

Quality slider

Slider from 0 to 8:

In the output area, click on Output format  .  A navigation rail opens listing all the 
possible output formats

1

Select the format of your choice2

Click on the Option menu   below the Output format button. A window opens3

Define the settings4

PDF Searchable (recognized text in 
background + original image on 
top of it) (default)

•

PDF Image (original image only)•
PDF Text and graphic zones 
(recognized text only, image as 
graphics)

•

PDF Text over image (image in the 
background and recognized text on 
top of it)

•

0: minimal size•
1: very small size•
2: small size•
3: favor size over quality•



Readiris PDF

                                                                                                       48 of 82 

Check boxes: 
Depending on the PDF type you select, 
some of these options are made 
available. 

Security

Password to open
Set a password (max. 32 characters) that 
will be required at opening of your 
document

Password to edit

Set a password (max 32 characters) that 
will be required to edit your document. 
'Password to open' and 'Password to 
edit' should be different.

Printing allowed (if password to 
edit is checked)

No per default. If yes, high resolution or 
low resolution

Changes allowed (if password to 
edit is checked)

No per default. If yes, set the change 
type you are allowing in your document 
(from a drop-down list)

Enable text access for screen 
reader devices for the visually 
impaired (if Password to edit is 
checked)

No per default. If yes, then the text can 
be read by screen readers for blind or 
visually impaired users.

Enable copy (if Enable text 
access is checked)

No per default. If yes, then the text can 
be copied.

Signature

Available digital IDs or certificates are 
listed in a drop-down list.  This is a 
global signature of the PDF file.  Make 
sure your certificate is loaded in Readiris 
PDF before using it.  If your certificate 
does not appear, restart the application.

Metadata
Title, subject, author and 
keywords

Set metadata to provide additional 
information about your file

 

4: medium quality•
5: favor quality over size•
6: high quality•
7: very high quality•
8: maximal quality•

JPEG 2000 compression•
Embed fonts•
Smoothing•
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PDF Compressed

Section Option Description

Generalities
PDF version 12 PDF versions to choose from

Quality slider
Slider from 0 to 8: same values as PDF 
settings

Security Same settings as PDF settings  

Metadata
Title, subject, author and 
keywords

Set metadata to provide additional 
information about your file

 

PDF Archive (PDF/A)

Section Option Description

Generalities

PDF type Same options as PDF settings

PDF version 6 PDF/A versions to choose from

Quality slider
Slider from 0 to 8: same values as PDF 
settings

JPEG 2000 compression
Check the box if you want to apply the 
JPEG compression 

Metadata
Title, subject, author and 
keywords

Set metadata to provide additional 
information about your file

 

Image

Section Option Description

  Image format

  Quality slider
Set a quality level for JPEG format (in 
percentage from 1 to 100)

 

TIFF multi pages•
BMP•
JPEG•
PNG•
TIFF single page•



Readiris PDF

                                                                                                       50 of 82 

Word

Section Option Description

Generalities

Paper size
Select the paper size from a drop-down 
list (default is automatic)

Document structure:

Exact: all detected paragraphs of text 
are placed in frames to ensure exact 
reproduction of the original document 
layout. The whole input image is placed 
in background to ensure maximum 
similarity to the original. This option 
offers less freedom for layout 
modification. 

Editable: the detected elements are 
placed in frames to ensure exact 
reproduction of the original document 
layout; graphic elements are created to 
allow the layout modification. 

Flowing: the layout of the original 
pages is reproduced as closely as 
possible with body text and page 
columns, using frames only for 
elements outside of the body text.

None: the layout of the original pages is 
not retained, all elements are written as 
body text in reading order.

Landscape Check the box for a landscape orientation

Metadata
Title, subject, author and 
keywords

Set metadata to provide additional 
information about your file

 

Exact (default)•

Editable•

Flowing•

None•
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Excel

Section Option Description

Generalities Document structure

3 choices:

Metadata
Title, subject, author and 
keywords

Set metadata to provide additional 
information about your file

 

PowerPoint

Section Option Description

Generalities Layout

3 choices:

Metadata
Title, subject, author and 
keywords

Set metadata to provide additional 
information about your file

 

HTML

Section Option Description

Generalities

Document structure:

Exact: all detected paragraphs of text 
are placed in frames to ensure exact 
reproduction of the original document 
layout. The whole input image is placed 
in background to ensure maximum 
similarity to the original. This option 
offers less freedom for layout 
modification. 

Flowing: the layout of the original 
pages is reproduced as closely as 
possible with body text and page 
columns, using frames only for 
elements outside of the body text.

Recreate source document (default)•
Tables and text•
Tables only•

Standard (default)•
Fit content•
Wide screen•

Exact (default)•

Flowing•

None•
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None: the layout of the original pages is 
not retained, all elements are written as 
body text in reading order.

Metadata
Title, subject, author and 
keywords

Set metadata to provide additional 
information about your file

 

EPUB

Section Option Description

Metadata
Title, subject, author and 
keywords

Set metadata to provide additional 
information about your file

 

Settings per destination

 

Local 

Section Option Description

  Path Define the path to your local output folder

 
Check box: Open the file after 
creation

Check that box for the file to open straight 
after export is finished

 

Cloud

With Readiris PDF you can send documents to Box, DropBox, MS OneDrive, Google 
Drive, or SharePoint.

 

Warning: You need a valid Box, Dropbox, MS OneDrive, Google Drive, or 
SharePoint account and an Internet connection to be able to save your 
documents there.

In the output area, click on Output destination  .  A navigation rail opens listing 
all the possible output destinations

1

Select the destination of your choice: Local, Cloud, or Email2

Click then on the Option menu   to define the settings of your output destination3
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Note: In Ribbon mode, go to tab Share or Convert.

 

Configuring the Connectors

The configuration to your favorite Cloud accounts is persisted.  Only the authentication is 
required again when the token has expired. 

 

Email

Once you have clicked the Save button, Readiris PDF opens your default mail client for 
you to compose your email.

 

In Ribbon mode, go to tab Convert > Output destination or to tab Share > Share. 

 

Once you have selected a Cloud as destination, click on the Option menu  .  A 
window opens.

1

Click on the folder icon to edit settings2

Follow the on-screen wizard instructions to configure your account (authentication 
and path)

3

Once you have selected the Email as destination , click on the Option menu  .  A 
window opens.

1

Enter your recipient email address and a subject2
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Print
 

Send to printer

 

In the Ribbon mode, go to tab Convert > Print and click on the Print button. 

 

Click on the Print button  in the Output area OR go to File Menu    and select 
Print.

1

The print page opens.2

Select a printer from the list.3

Click on the Printer settings icon  to edit the printer settings.4

Choose the pages to be printed from the following options: all pages, the current 
page or a custom range.

5

If you chose Custom range, enter page numbers and/or page ranges separated by 
commas. For example: 1,2,4-6

6

Start printing by clicking on the Print button   7
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How to obtain good recognition results?
 

The quality of the recognition results depends on a number of factors and you are 
advised to check the following points:

 

The document 
language

Make sure you select the right OCR Language in the User 
settings (ALD or Manual). Especially if your document mixes 
languages.

The quality of the 
scanned documents

If the scanned documents are too bright, or too dark, Readiris 
PDF might have trouble recognizing them.

The rotation of 
your image

Make sure the imported image has the right rotation. If not, 
use the Rotate tool in the Image processing options.

The resolution of 
your imported 
images

If you are using a scanner to scan documents, the image 
quality is also linked to the scanner settings. See the section 
Configure your scanner to make sure the right settings have 
been selected for your scanner.

Make the scan resolution is set to 300 dpi for regular 
documents and to 400 dpi for small print and Asian languages.

The recognition 
zones

see Page Analysis

 

Warning: an image of very poor quality will not be correctly recognized 
even after verification of the above points.
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How to do a right-click conversion?
You can access some quick actions via the right-click Menu of your File Explorer. 

 

Caution: If you have just installed Readiris PDF, you need to restart 
before this feature is available.

 

Click Open with Readiris PDF option if you want to:

In a File Explorer, select one or more:1

image files (.tif, .tiff, .jpg, .jpeg, .bmp, .png)•

PDF files (.pdf)•

Microsoft Office Word documents (.doc, .docx)•

Microsoft Office Excel files (.xls, .xlsx)•

Microsoft Office PowerPoint files (.ppt, .pptx) •

Right-click and go to Readiris PDF in the menu2

Select an action:3

If you selected one file only, the available actions are:•

Open with Readiris PDF•

Convert to PDF•

Convert to Word•

Convert to Excel•

Convert to PowerPoint•

If you selected more than one file, the available actions are:

Tip: The order of your Convert or your Merge follows the 
order of your selection/clicks.

•

Open with Readiris PDF•

Convert to PDF•

Merge to PDF•

open your files directly in Readiris PDF•

select another output file format•

change the settings of the selected output format•
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How to use the Text Editor?
To enter editing mode

In the Ribbon mode, go to tab Edit > Edit section > Edit Text.

 

To edit a word, a sentence or a paragraph

 

Tip: To select text in caret navigation, you can use the keyboard shortcut 
Shift+Right or Left Arrow

 

To move or resize a paragraph

 

To change font type, font size, font color or font style

 

Go to Edit in the Icon bar 1

Click on Text  .  The Settings panel opens.2

Click in the sentence to enter caret navigation. An edition box is displayed around 
the paragraph. 

1

Edit text (add or remove characters)2

Click in the paragraph to enter caret navigation. An edition box is displayed around 
the paragraph.

1

Thanks to the move cursor, move the paragraph by dragging and dropping the box 
where you want.  

2

Thanks to the resize cursor, resize the paragraph as you want (text can stretch or 
shrink).

3

Click in a paragraph to enter caret navigation. An edition box is displayed around the 
paragraph.

1

Select the text you want to edit.2

Select the font options in the Settings panel.3
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To change paragraph alignment
Click in a paragraph to enter caret navigation. An edition box is displayed around the 
paragraph.

1

Select the alignment options in the Settings panel. The full paragraph is aligned as 
selected.

2
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How to sign a PDF document
Two ways of signing using digital IDs are available:

 

Sign with a stamp
 

The signature stamp is displayed in one location, but is global for the document. 

Select a PDF output format for the export. 

In the Ribbon mode, go to tab Protect > Sign section and click on IDs & Certificate.

 

Sign with the PDF output settings
 

The signature is not displayed on the document.

 

Tip: Available digital IDs or certificates are listed in a drop-down list.  
Make sure your certificate is loaded in Readiris PDF before using it.  If 
your certificate does not appear, restart the application. 

Go to Comment in the Icon bar 1

Click on Signature  . The Settings panel opens.2

Click on the page. Draw a stamp box. Thanks to the move cursor, you can place the 
stamp where you want. 

3

In the Settings panel, select a digital ID available from the 'Digitally signed by' drop- 
down list

4

In the Reason field, select a reason from the drop-down list or enter a new reason 
(free and optional). 

5

In the Location field, enter a location (free and optional)6

In the Contact field, enter the name of a contact (free and optional)7

Go to the Output area, and choose a PDF output format1

In the Settings, go to the Security section2

Select a digital ID available from the 'Signature' drop-down list. The signature is global 
for the document

3
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How to view, add, rename or 
delete Bookmarks
 

View
You can view bookmarks in your document via the Bookmark panel in the left 
navigation panel.

The list of existing bookmarks is displayed.

When you click on a bookmark, the target page is displayed.

 

Add, Add child, Set Destination
Add

You can add bookmarks on selected pages. 

A new bookmark is created, named and ordered after the targeted page number.

If you cut/copy and paste a page, the bookmarks targeting that page are copied and 
pasted too.

In the Ribbon mode, go to tab Comment > Bookmark section > Add to add a bookmark.

In the Modern mode, go to tab Comment > Bookmarks to add a bookmark.

 

Add child

By right-clicking on a bookmark, you can also add a child to it.

Click on Bookmark panel1

Go to the Thumbnail Panel1

Select the page you want to bookmark2

Go to the Bookmark panel3

Click Add  .  4

Go to the Thumbnail Panel1

Select the page you want to bookmark as a child2

Go to the Bookmark panel3

Right-click on the bookmark under which you want to add a child bookmark4

Select Add child5
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A new child bookmark is created, named and ordered after the targeted page number.

 

Set destination

You can redefine the destination of an existing bookmark. 

The bookmark points to the new selected page.

 

Rename

The bookmark is renamed.

 

Delete

The bookmark is deleted.

If you delete a page, the bookmarks targeting that page are deleted too.

Caution: for the Bookmarks to be included in your exported 
documents, the output format must be a PDF.  

 

Go to the Thumbnail Panel1

Select the page on which you want to set the destination2

Go to the Bookmark panel3

Right-click on the bookmark for which you want to assign the destination page4

Select Set destination5

Go to the Bookmark panel1

Right-click on the bookmark you want to rename2

Select Rename3

Enter the new name of your bookmark in the pop-up widow.  Click OK. 4

Go to the Bookmark panel1

Right-click on the bookmark you want to delete2

Select Delete3

A confirmation message is displayed. Click Yes.4
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How to view, add, comment or delete 
Attachments
 

View
You can view attachments in your document via the Attachment panel in the left 
navigation panel.

The list of Attachments is displayed.

If you select an attachment, the page on which it is located is displayed. An attachment 
icon  shows you the location.

 

Add
You can add attachments to your document.

The file is attached on the current page. The attachment icon  appears.  Thanks to the 
move cursor, you can place the attachment where you want. 

In the Ribbon mode, go to tab Comment > Attachment section > File to add a file as 
attachment.

In the Modern mode, go to tab Comment > Attachments to add an attachment.

 

Comment
You can add a comment on a selected attachment.

A comment is added.  

Simply click the bin icon to delete your comment if needed. 

Click on Attachment Panel. 1

Go to the Attachment panel1

Click Add  . The file browser opens. 2

Select your file to import3

Click Open4

Go to the Attachment panel1

Select the attachment you want to comment (or select directly the attachment icon 
)

2

In the Settings panel, click on the plus button to add a comment. 3
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Save

The attachment is saved.

 

Delete

OR

The attachment is deleted.

 

Caution: for the Attachments to be included in your exported 
documents, the output format must be a PDF. 

 

Go to the Attachment panel1

Right-click on the attachment you want to save2

Select Save3

The file browser opens, select the location to save the file4

Click Save5

Go to the Attachment panel1

Right-click on the attachment you want to delete2

Select Delete3

A confirmation message is displayed. Click Yes.4

Right-click on the attachment icon 1

Select Delete. 2
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How to add a QR code
 

QR codes can be very handy nowadays as they can be read and understood by mobile 
devices.

Let's take, for example, the QR code 'mailto'.

 

The QR code is included in your document.  Anyone who scans it with a smartphone can 
easily send an email to that recipient or save it as a contact. 

 

Presets for QR Type help you with some commonly used QR codes.   
These presets come with sample content that you can modify to suit your needs. 

The list of presets is as follows: Call me, Visit my website, Mail to, Send SMS, WiFi 
credentials, Come and visit (map URL), Share contact details (business card).

You can take the following actions on these presets:

Save changes to this barcode preset. 
Select an existing preset. Fill in the Content field and click on Save.

Create new barcode preset. 
Click on Create. Fill in the Preset Name, add the Content and click on Save. 

Delete this barcode preset. 
Select an existing preset and click on Delete.

Go to Edit in the Icon bar 1

Click on Add Barcode  .  The Settings panel opens2

Select type QR (default selection)3

Select the 'Mail To' Preset4

Enter an email address in the Content field after the 'mailto:' prefix. Example: 
mailto:john.doe@company.com

5

Draw the box on the page. The QR code is displayed6

Drag and drop the barcode box wherever you want.  Rotate and resize it according to 
your needs

7

Click on Save   to export it in your favorite format (PDF, Image, DOCX, HTML 
or PPTX). 

8
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How to search and replace
 

The Search box in the title bar allows you to search and find text in the active/current 
document.  

In a second step, you can replace the found text with a new text. 

 

Search

Replace

 

Note: the searching mode does not allow selecting text. To select text, 
exit the searching mode by closing the Settings panel ( ).

 

Open the document you want to search (single-page view)1

Go to the Title bar > Search text or press F32

Enter the text or phrase you want to locate3

Click on the Search button  or press Enter4

The search results are displayed in the Settings panel (you are now in searching 
mode).  
It shows you the number of instances and the list of results within context.  In the 
single-page view, the instances are highlighted in yellow. 

5

Enter your new text in the Replace with field1

Select the instance in which you want to replace text.  Click on Replace 2

To update all instances at once, click on Replace all 3
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How to automatically clean up your 
scanned images?
 

You can clean up images directly at scanning phase by setting and activating the On The 
Fly operations.   

 

 

As a result, the scanned images are already processed and cleaned up as per your 
selection of operations.  

The setting of these operations is saved and the activate/deactivate button gives you the 
flexibility to use it only when needed.  

In the input area, activate the On The Fly operations by clicking on the button 1

Click on the Option menu   (Scan settings) below the Scan button  . A window 
opens.

2

Select your scanner from the drop down list3

Select one or more image processing operations among:

Be aware however that the more operations you select, the more time the scanning 
will take.

4

Delete blank pages◦

Auto-rotate pages◦

Deskew pages◦

Remove black borders◦

Click on Scan   or press F45
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How to scan multiple pages into one 
document
 

 

For more information on configuring your scanner, go to Configure your scanner.

This same procedure applies to input from Files. Click Open    or press F5 instead of 
Scan or F4.  Simply select multiple files of supported formats in the file browser.  Click 
Open. 

To create a new document, go back to the input area and click on the slide button to get 
the New document option (see New document setting).

 

Go to the input area (also capture/import area) and click on the slide button to get 
the Append option (see Append setting).

Ribbon mode 
Home > Capture

Modern mode

Input area

1

In the same input area, scan as many documents as you want by clicking on Scan 
 or by pressing F4.

2



Readiris PDF

                                                                                                       68 of 82 

How to separate and name your 
documents on import
 

When scanning documents 
For example, you want to automatically separate the invoices you scan using a blank 
page as a separator. You want to remove the separator pages, and you want to name the 
files with the prefix 'invoice', the date and a counter. 

In the input area, make sure the 'On the fly' operations are enabled (enabled per 
default).

1

Click on the Option menu   (Scan settings) under the Scan button  . A window 
opens.

2

Select your scanner and keep the option 'Prompt for document name' unchecked. 3

In the Image Processing section, select the options you want. 4

In the Separation section, select the 'Blank page is detected' condition.  Check the 
box 'Remove separator pages'.  Check the box 'Duplex' if your scanner is a two-sided 
scanner.  

5

In the Naming section, go to the Structure field.  The default preset for this 
separation method is <DOCUMENT>_<DATE>_<TIME>_<COUNTER>.

6

Delete the <DOCUMENT> tag and type 'Invoice' instead.7

Delete the <TIME> tag. 8

The resulting naming structure is: Invoice_<DATE>_<COUNTER>. These changes are 

saved until you click the Reset button  to restore the default naming structure.

9
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The automatic separation and naming are ready.  You can click on Scan   or press F4.

A new tab opens for each new document in the tab bar.  

 

When opening a document from file
For example, you want to automatically separate a PDF file containing event tickets 
based on a barcode (anywhere on the page) and you want to name the files with the 
prefix 'Ticket', the barcode value, the date and a counter. 

In the input area, make sure the 'On the fly' operations are enabled (enabled per 
default).

1
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Click on the Option menu   (Input settings) under the Open button . A window 
opens.

2

Select your file format and uncheck the option 'Use file name'. 3

In the Image Processing section, select the options you want.4

In the Separation section, select the following conditions: 'Barcode is detected', 'Any 
type', and 'Any' Barcode content. The 'Remove separator pages' checkbox is not 
checked. 

5

In the Naming section, go to the Structure field. The default preset for this 
separation method is <FILENAME>_<DATA>_<COUNTER>.

6

Delete the <FILENAME> tag and type 'Ticket' instead.7

Keep the <DATA> tag (see the 'extracted data' tag).8

Between <DATA> and <COUNTER>, add  the <DATE> tag followed by an 
underscore. 

9

The resulting naming structure is: Ticket_<DATA>_<DATE>_<COUNTER>. These 

changes are saved until you click the Reset button  to restore the default naming 
structure.

10
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The automatic separation and naming are ready.  You can click on Open   or press F5.

A new tab opens for each new document in the tab bar.  
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How to create and use a Smart Zone
 

Create a Smart Zone
See also chapter Process > Edit > Smart zone

This Smart Zone now defines the specific area that can be used to automatically separate 
documents on import.  

 

Use a Smart Zone
See also 'on the fly' operations.

For example, you want to automatically separate the pages you scan based on a text that 
is always in the same place on the page.  You want to name the files with the Smart Zone 
value, the date, and a counter. 

Select the page on which you want to create a new zone.1

Click Edit   in the Icon bar or Ribbon.2

Click Smart Zone . The Settings panel opens. 3

Click the plus button and draw a box around the zone you want to define. The box 
can contain text or a barcode. The content is automatically recognized. 

4

Fill in the Name of your Smart Zone in the Settings panel.5

Drag and drop the box wherever you want.  Resize it to fit your needs. 6

In the input area, make sure the 'On the fly' operations are enabled (enabled per 
default).

1

Click on the Option menu   (Scan settings) under the Scan button  . A window 
opens.

2

Select your scanner and keep the option 'Prompt for document name' unchecked.  3

In the Image Processing section, select the options you want.4

In the Separation section, select the following conditions: 'Smart zone is detected', 
your Smart Zone, and 'Any' content. The 'Remove separator pages' checkbox is not 
checked. 

5

In the Naming section, go to the Structure field. The default preset for this 
separation method is <DOCUMENT>_<DATE>_<TIME>_<DATA>_<COUNTER>.

6

Delete the <DOCUMENT> tag.7
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The automatic separation and naming are ready.  You can click on Scan   or press F4.

A new tab opens for each new document in the tab bar.  

Delete the <TIME> tag.8

Move position between the <DATA> and the <DATE> tags.9

The resulting naming structure is: <DATA>_<DATE>_<COUNTER>. These changes are 

saved until you click the Reset button  to restore the default naming structure.

10
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About
To find information about this software

 

 

There you find the software version and the Serial number.

Go to File Menu  1

Select Info 2
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Search for updates
 

 

OR

 

 

In the Ribbon mode, go to tab Help and click on the Updates icon. 

 

Click on Help   in the Icon bar or Ribbon (tab Help)1

Click on the Updates icon 2

Go to File Menu  1

Select Update 2
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Keyboard shortcuts
Navigation
Description Keyboard Shortcut

Toggle between light theme or dark theme  
(user interface)

F11

Toggle between modern mode or ribbon 
mode  (user interface)

F12 

Select multiple thumbnails or pages (multi- 
page view)

Shift+Click, Shift+Up or Down Arrow 
Keys, Shift+Page Down, Shift+Page Up

Select text in text editor Shift+Right or Left Arrow keys

Zoom in or zoom out in the main Viewer (single 
or multi-page view) and in the Thumbnail panel

Ctrl+ mouse wheel

Zoom in in the main Viewer (single or multi- 
page view)

Ctrl+ "+" in the numeric keypad

Zoom out in the main Viewer (single or multi- 
page view)

Ctrl+ "-" in the numeric keypad

 

Commands
Description Keyboard Shortcut

Go to Open section in the File menu Ctrl+O

Go to Info section in the File menu Ctrl+I

Go to Page in the Viewer toolbar Ctrl+G

Cut Ctrl+X

Copy Ctrl+C

Paste Ctrl+V (per default: paste after)
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Go to Search bar Ctrl+F or F3

Undo Ctrl+Z

Redo Ctrl+Y

Select all Ctrl+A

Save as... Ctrl+S

Print current document Ctrl+P

Delete Del

Rename document in the tab bar F2

Open file F5

Start scanning F4

Start exporting F9

Open Help (user guide) F1
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User Guide
 

 

OR

 

 

In the Ribbon mode, go to tab Help and click on the User Guide icon. 

Click on Help   in the Icon bar1

Click on the Documentation icon 2

Go to File Menu  1

Select Help 2
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Uninstall Readiris PDF
Should you want to remove Readiris PDF from your computer, follow the Uninstall 
instructions of your Operating System.

 

On a Windows 10 OS:

 

 

Close Readiris PDF1

From the Windows Start menu, go to Settings > Apps > Apps & features2

Select Readiris PDF from the list and click Uninstall3
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Glossary
Duplex scanning

Duplex scanning, or two-sided scanning, refers to the ability of a scanner to scan both 
sides of a sheet of paper simultaneously.

ICR

ICR stands for Intelligent Character Recognition, I.R.I.S.' proprietary technology for 
reading printed handwritten characters.

iHQC

iHQC stands for intelligent High-Quality Compression, I.R.I.S.' proprietary, efficient 
compression technology for PDF image format.

Inpainting

Inpainting is the process of filling-in damaged or missing parts in a designated region of 
the visual input to present a complete image.

On The Fly

This phrase describes something that is being changed while the process that the change 
affects is ongoing.

Serial number

Also activation code. That is the number that allows you to fully use Readiris PDF 
software.

Simplex scanning

Simplex scanning, or one-sided scanning, refers to a scanner that scans only one side of 
the paper.

Smart Zone

A Smart Zone is an area you can draw anywhere on the page where the data you want to 
extract appears, and which you can save in the custom Smart Zone library. A Smart Zone 
has a fixed size and position on the page. The type of Smart Zone is automatically 
detected and extracted by Readiris, which means that Readiris can determine whether it 
is a text or a barcode and automatically configure the Smart Zone accordingly. When 
using the Smart Zone for on-the-fly separation, Readiris searches for data in this zone on 
each imported page. If data is found (text or barcode, data that is present with any 
content, that changes content or that contains a specific value), the separation condition 
is met and the separation will take place on that page. The data will be used to name the 
file if it is defined in the naming structure with the <DATA> tag. Note that if a Smart Zone 
is defined on a large page size and you import small pages, the Smart Zone will be 
outside the imported page. This Smart Zone will be recognized as empty.
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Legal Notices
 

Copyright

© 2023 I.R.I.S. SA. All Rights Reserved.

I.R.I.S. owns the copyrights to the Readiris PDF software, to the online help system and to 
this publication.

The software described in this document is furnished under a license agreement which 
states the terms of use of this product. The software may be used or copied only in 
accordance with the terms of that agreement. No part of this publication may be 
reproduced, transmitted, stored in a retrieval system, or translated into another language 
without the prior written consent of I.R.I.S.

Documentation version 1.5.0.10 - Product version 23.0

The information contained in this document is the property of I.R.I.S. Its content is subject 
to change without notice and does not represent a commitment on the part of I.R.I.S. Any 
modification, error correction, or feature updates made in the actual software may have 
not been timely updated in this user manual. You may refer to the software itself for 
more accurate details. Any misprints, translation error, or inconsistency with existing 
software, will be updated timely.

This manual uses fictitious names for purposes of demonstration; references to actual 
persons, companies, or organizations are strictly coincidental.

Trademarks

Readiris PDF logo and Readiris PDF are trademarks of Image Recognition Integrated 
Systems S.A. (I.R.I.S. SA)

OCR ("Optical Character Recognition"), Linguistic technology, ICR ("Intelligent Character 
Recognition") technology, MICR ("Magnetic Ink Character Recognition") technology, BCR 
("Bar Code Reading") technology, OMR (Optical Mark Recognition), iHQC ("intelligent High 
Quality Compression") technology and HQOCR ("High Quality OCR") technology by I.R.I.S.

Document Generation by I.R.I.S.

Send to the Cloud by I.R.I.S.

Windows® is a registered trademark of Microsoft Corporation in the United States and 
other countries.

All other products mentioned in this documentation are trademarks or registered 
trademarks of their respective owners.

Patent Statements

Readiris PDF integrates the following patent-granted I.R.I.S. technologies: US8068684; 
US8331706; US8666185; JP5501958; US8995780; EP2143039A2; EP14163365.1; 
BE1022166; BE1022635; US8913836; BE1022630; US8897600; BE1022636; US8811751; 
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US8411940; BE1021013; US9058517; US9183636; US9311558; BE1025006; BE1022562; 
US9798943; BE1024194; US9836646; BE1024836; CN106462773B; 
CN106255979B; JP6609267; JP6693887B2; GB2571530; BE1026039; GB2572386; 
BE1026159; BE1026095; US11270143B2.

Disclaimer

The content of this document was created and arranged with the utmost care.

I.R.I.S. SA assumes no responsibility for the accuracy, completeness and timeliness of the 
provided content.

Data privacy

We respect your privacy and take great care to protect your information. We will collect, 
process, and use any data received from you under the condition of confidentiality and in 
accordance with this Privacy Policy.

 

 

 

 
I.R.I.S. SA/NV

rue du Bosquet 10, B-1348 Louvain-la-Neuve

+32 (0) 10 45 13 64 - www.iriscorporate.com

https://www.irislink.com/m1783/Privacy-Policy.aspx
http://www.iriscorporate.com
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